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Our Club’s January is slowly coming to an end. I was happy to 
see so many of us participating in this month’s activities and our 
most recent Competition. Kudos to those of us who were lucky 
enough to garnish recognition.  If you scored an 8 or  a 9 this 
month take the accolades and honors you deserve.   Remember, 
if you didn’t do as well, there is always next month to let your im-
ages shine.  
One note of importance, there will be a second Print competition 
this coming month.  Please consider entering a print or two of 
your choice from among some of your wonderful images. Mike 
Miglino will be in touch with delivery info and expectations for the 
night of Feb 9th. So stay tuned for his announcement. 

I’d like mention to those who have contacted me in the past few months 
about joining our club. Why not considering joining now?  We are offering 
a discounted membership that will allow you to participate in our activi-
ties and completions for the remainder of the season. 
We’d like very much to have some new members who can share in the 
fun and provide us with their valued opinions. You also may have a good 
time learning and participating.  Contact me for details. 
Now for the current members, who have not been participating in our 
critiques and events, not to mention our competitions.  We would love to 
have you join us and share with us your views & experiences.  In that 
way we can all learn from each other. Joining a club is only part of the 
experience, being active is the rest. Hope to see you soon. 

ConƟnued on page 4. 

Photographing Doors and  Windows-Architectural Elements - Dennis Arculeo 
Tips: 
1. Expose for the window.
2. Fill the frame/meter off the window.
3. Use manual mode to lock in your settings.
4. Expose for the subject. Switch to spot metering and Meter

off your subject (you may need to add exposure compen-
sation).

5. To achieve a good exposure on both window and its inte-
rior by shooting two images: one exposed for the window
and one for the interior.

6. Then combine in post processing.

You already know that light is the most important element in every 
single photograph you take. Sometimes you’re lucky enough to find 
great light, and your photos practically take themselves. At other 
times you are stuck with some really challenging light, and you’ve got 
to employ some strategies to make the best out of the situation. 

Perhaps no lighting situation presents quite the same sort of chal-
lenge as windows and doors do. The light that comes through an 
opening in a building—whether it is covered by a piece of glass or 
not—is extremely bright compared to the ambient light in a room. If 
you don’t think through a shot that includes a window or door, you 
may end up with a bright, white, burned-out rectangle where that win-

dow or door is supposed to be. So is photographing windows and 
doors just an impossible task? Read on to find out. 

You have more than likely taken photos that are lit by the light from 
a window. It can be a great way to light a portrait or a still-life image, 
because the light itself is indirect and filtered. Even light that shines 
directly through a window can be softened up with a simple sheer 
curtain or a photographer’s diffuser. If you place your subject next to 
this type of light, you’ll get a beautiful, three-dimensional looking 
image with great detail and form. 

But what if you include the window in the image? That’s a different 
story altogether. When you have a photo that includes the interior of 
the building as well as a window, it’s nearly impossible to capture 
detail in both parts of the scene—at least not in a single shot. You 
can expose for the interior and get a nice detailed photo of the room 
with a bright, white square where that window is, or you can 
expose for the window and get a nice view of what’s on the other 
side of it, along with a dark room without a lot of detail in it. Some-
times it really is going to be OK to just make that choice. 

A subject sitting indoors next to the window is often going to be 
more important than what’s outside the window—unless you have 
an image that requires the context of what’s outside (if she’s look-

Feb 2nd  Image CriƟque  Member Images  Members CriƟquing Members - Zoom 

Feb 9th  2nd Print CompeƟƟon  C&M Physical Prints  Judge: Flint Gennaro  

Feb 16th  Monthly CompeƟƟon  AS: Windows & or Doors Judge: Phil Echo  - Zoom 

March 2nd  Image CriƟque  Member Images  Members CriƟquing Members - Zoom 
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Award  - First Place (9) 

HM - Honorable MenƟon (8) 

At the Museum - Len Rachlin 

Award 

WaiƟng Room ESP - Dennis Arculeo 

Award 

Interior of circular stairway - Herb Goldberger 

Award 

Stairwell - Marianne Bury 

Award 

Up Coming Assigned Subjects  
 

Windows/Doors  - February 2023 
Any Macro with an insect - March 2023 
One color to bring out the Main subject - 
April 2023 
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San Diego Terminal - Dennis Arculeo 

HM 

Christ Church Quebec Canada - Lauren Arculeo 

HM 

A quiet moment - Phyllis PeƟto 

HM 

View From the Second Floor - Marianne Bury 

HM 

Award  - First Place (9) 

HM - Honorable MenƟon (8) 
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   Photographing Doors and  Windows-Architectural Elements - Dennis Arculeo 

ing out the window at an approaching storm, for example, it may be 
important to include the storm clouds in the shot). But in most cases, 
you just need to make sure the subject is well-exposed. And a 
burned out window isn’t always a bad thing—it can make your image 
look mysterious and even a little bit ethereal. So if you don’t have a 
great reason to include the world outside that window, you may 
simply choose to let it burn out. 
 

On the other hand, it could be that the world outside the window is 
the whole point of the shot. In that case, ask yourself if it’s OK to let 
everything else in the photograph become a silhouette. Let’s say, for 
example, that your cat is sitting in the windowsill, watching the snow 
fall outdoors. If you expose for the window, then the cat is going to 
become an all-black silhouette. But most of the time, a silhouetted cat 
is going to be perfectly identifiable to anyone who sees it, so in this 
situation it might be the right choice. 

How to expose for the window 

You can get a good exposure for the window by putting your camera 
in manual mode and then filling the frame with the window. Dial in 
your camera’s suggested settings and then add the person/cat or 
other silhouetted object to the scene. Note that your camera’s sug-
gested settings are going to change once that subject enters the 
frame, because your camera’s meter works in averages and it will 
always attempt to give you an exposure that averages everything in 
the scene out to roughly a middle gray tone. But in this situation 
you’re going to get the wrong exposure for the window if you make 
the suggested changes after the subject enters the frame—so leave 
things as they are and take the photo. You’ll get that silhouetted sub-
ject and a nicely exposed outdoor world. 

How to expose for your subject 

If you want your subject to be correctly exposed (which will result in a 
burned out window) your method is going to be somewhat different. 
Switch to spot metering and take a meter reading off of your subject. 
Now remember again that your meter is going to assume that the 
spot is a middle gray tone, which may or may not be the case de-
pending on who or what your subject is. If your subject is a gray cat, 
you’re in luck. Otherwise, you will have to make some guesses or 
default to metering off of a photographer’s gray card, which is the 
easiest way to get an accurate exposure. 

Most faces are about one stop above middle gray in tone, so after 
you take that spot meter reading you’ll need to add exposure com-
pensation of +1 to get the right exposure. With subjects who have 
darker skin, you may not need to use exposure compensation at all, 
or you may need to use negative exposure compensation. If all of this 
is starting to make your head spin, there’s a very simple solution—
have your subject stand as if you’re about to take the photo, then ask 
her to hold a gray card in front of her face. Take the spot meter read-
ing off of the gray card, lock in the settings, then have her drop the 
card for the photo. 

But what if I want a well-exposed window and a well-exposed 
interior? 

Unfortunately, I don’t have the answer you’re probably looking for—
the truth is that there’s just too much dynamic range between the 
world outside that window and the world inside whatever room you 
happen to be standing in. Your camera—and most modern camer-
as—just isn’t capable of capturing that entire range of tones in a sin-
gle exposure. No matter what you do, you’re going to have to choose 
between a well-exposed window/dark room or a well-exposed room/
burned-out window. It’s like trying to shoot the moon in the evening 
and expecting to see detail on both that lunar landscape and the 
earthly one. 

Now, I know you’ve seen images that appear to defy this explanation, 
I’ll let you in on a secret: those photos are not single exposures. The 
photographer has combined two different photos—one that he ex-
posed for the interior, and one that he exposed for the window. This 
is actually a really simple process provided that you have 
a tripod and a post processing package that can help you accomplish 
it. 

The reason you need the tripod is because the two exposures have 
to line up perfectly, so you can easily combine them. The sturdier the 
tripod, the better, because you don’t want any change in position 
between one frame and another, even though you’ll be messing 
around with your camera’s settings between exposures. Use the 
techniques outlined above to determine the correct exposure for the 
interior and for the window, and then take one shot each using the 
suggested settings. 

How to combine images 
Some post processing packages will let you open two images as 
separate layers of the same file, but I’m going to give you the manual 
way to do this since you may not be lucky enough to own software 
that makes it easy on you. 
First, you need to open up each image in your post-processing pack-
age. Go to the image with the correctly exposed interior and choose 
Select > All, then Edit > Copy. 
 
Switch to the second image and make sure the layers panel is visi-
ble. Choose Edit > Paste and the copied file should be added as a 
second layer. Now shift +click to select both layers, and choose Edit 
> Auto-Align Layers. Select “Reposition Only,” then click OK. Your 
software will automatically find the edges of each image and align 
them, just in case you were a little off between the two exposures. 
Now click the top layer (the one with the correctly exposed interior 
and blown-out window) and click on the little circle-in-square icon at 
the bottom of the layers panel. Go to Layer > Layer Mask > Reveal 
all. 
Now go down to the left corner of the window and find the two over-
lapping squares. Just above them is a smaller set of overlapping 
squares—click on them to select a black foreground and white back-
ground. Now choose the paintbrush tool above (note that it might be 

ConƟnued From page 4. 

ConƟnued on page 10. 
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Award  - First Place (9) 

HM - Honorable MenƟon (8) 

Award 
AŌernoon at the Park - Len Rachlin 

Award 

Magnificent Rose - Larisa Livshits 

Award 

SerengeƟ leopard - Herb Goldberger 
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HM 
At Snug Harbor - Sue Svane 

HM 

Abstract - Phyllis PeƟto 

HM 
ComposiƟon with Apples and Root - Len Rachlin 

HM 

Pondering Leaf Monkey - ScoƩ Allen 

HM 

Maasai woman resƟng - Herb Goldberger 
HM 

Another Brooklyn Rose - Sue Svane 
Award  - First Place (9) 

HM - Honorable MenƟon (8) 
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HM 

Monument Valley SolsƟce =Dennis Arculeo 

HM 

Slanted PerspecƟve - Marianne Bury 

HM 
Lancaster AŌernoon Ride into Town - Dennis Arculeo 

HM 

A Church with many Angles - Shelley Levine 

Award  - First Place (9) 

HM - Honorable MenƟon (8) 
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Award  - First Place (9) 

HM - Honorable MenƟon (8) 

Award 

Entrance in the Round - Dennis Arculeo 

Award 

Mother and Child  - Len Rachlin 

Award 
Sewing NoƟons in Black and White - Marianne Bury 

Award 

Wipe Out!! - Dennis Arculeo 
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Award  - First Place (9) 

HM - Honorable MenƟon (8) 

Gissell - ScoƩ Allen 

HM 

HM 

Finding cans for Money - Shelley Levine 

HM 

SƟll Life with Glassware and Flowers - Len Rachlin 

HM 

Sunburst and Flurries - Marianne Bury 
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hidden by the pencil tool) and choose a smallish brush tip from the se-
lections at the top of the window. 
Now zoom in and make sure that the layer mask (not the image) is se-
lected in the layers panel. Carefully paint over the top layer where the 
window is. You’ll reveal the correctly exposed window in the layer be-
low. When you’re finished, you can merge the two layers to create a 
complete image. 
 
Conclusion 

With the right tricks it is possible to get a nice interior shot that includes 
both window details and foreground details, but think first about whether 
or not you need to have details in both areas. Chances are that you can 
get a strong image in a single exposure, provided you’re willing to sacri-
fice some detail in certain parts of the scene. If you think it through and 
you’re just not willing to let go of that detail, that’s OK too. A little post-
processing practice and you’ll be able to quickly combine two images 
and create a single photo that has all the detail you want. 

Summary 

1. Expose for the window 
2. Fill the frame/meter off the window 
3. Use manual mode to lock in your settings 
4. Expose for the subject 
5. Switch to spot metering 
6. Meter off your subject’s face (you may need to 

add exposure compensation) 
7. OR meter off a gray card 
8. Achieve a good exposure on both window and 

interior 
9. Shoot two images: one exposed for the window 

and one for the interior 

Windows and Doors ConƟnued From page 4. 

HM 
Pelican - Herb Goldberger 

HM 

Saranac Railroad - Herb Goldberger 
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As a serious photographer, how can you know which ones to sub-
mit to, and if you do choose to submit to one, how to maximize 
your chances of winning? Here is everything you need to know 
about photo contests. 
 
What Is the Purpose of Photo Contests? 
For the professional photographer, what purpose do photo contests serve? Can 
they help you grow your talents or gain recognition? Are you in the contest 
simply for the fame? 
The answer to this question is going to vary depending on your goals. For 
some, a photo contest is a chance to gain marketing exposure. Getting your 
name out there as the winner of a prestigious contest is one way to increase 
your exposure. For others, the goal is the prize, which may be in the form of 
gear or even cash. 
If you are a professional who is earning money through your photography, be-
ing able to say that you won a particular contest can help you gain more cus-
tomers. People pay attention when someone has been called the “best of,” 
even if there is no good reason to do so. If you are looking to gain exposure, 
winning a photo contest is a great way to do it. 
For others, the prize may be the goal. If you are in it to win a prize, make sure 
the contest actually offers one. Know what the prize is and if it is worth your 
efforts before you sign up. 
 

Read the Terms Carefully 
Before you sign up for any photo contest, be certain you understand the terms 
and conditions. The organizations who put out photo contests don’t do it simply 
for the love of photography. They often have their own agenda, and you need to 
understand the role your photograph plays in that. 
For example, the Smithsonian Photo Contest has a $5,000 grand prize and no 
entry fee. This can be quite tempting to an up-and-coming photographer, but if 
you read the terms and conditions, you will come across this: 
“By entering the contest, entrants grant the Smithsonian Institution a roy-
alty-free, worldwide, perpetual, non-exclusive license to display, distrib-
ute, reproduce and create derivative works of the entries. The Smithson-
ian Institution will not be required to pay any additional consideration or 
seek any additional approval in connection with such uses.” 

Read that again. Is that the kind of license you want to give up on your art with 
only a slight chance of compensation? If so, then by all means join the contest, 
but if you value the right to your art, you may want to think twice. Before putting 
an image in any photo contest, know how it is used and what rights you are 
giving away by doing so. 
Now, most photo contests will take some rights to the winning photograph, and 
most photographers would be happy to sell the rights for the cash or gear prize. 
Yet that does not mean the grant needs to be a perpetual license, nor does it 
mean that all entrants should have their rights stripped. Finally, make sure that 
the agreement does not grant third-party use of your image without your ex-
press, written permission. 
Finally, look at the cost. Some photo contests are free, but many are cleverly 
disguised as income-generating vehicles for the parent company. Paying a fee 
is not necessarily a bad thing, but make sure you know what it is and are willing 
to enter for that cost. 
As you read through the terms and conditions, try to understand what the pur-
pose of the contest is. Often, knowing the purpose will show you quite a bit 
about whether or not the contest is something you want to participate in. 
 

Know the Rules 
Before submitting for any contest, take a careful look at the rules. Know what 
the deadline for submission is, including the time, and how judging will take 

place. Learn what file formats are acceptable, how much photo manipula-
tion is allowed and the size of the file you can send. 
The last thing you’d want to do is send an image that is cropped to the 
wrong ratio or send a RAW file when only JPG are acceptable and get 
disqualified as a result. 
 

Do’s and Don’ts of Photo Contests 
If you are considering signing up for a photo contest, consider these do’s 
and don’ts. 
 
Do: 

· Consider your goal – Do you want to win the prize, or learn some-
thing to help your photography? Will you be able to achieve your goal? 
For instance, if you want to grow as a photographer but the contest will 
not provide feedback, it may not be worth entering. 
· Read the terms and conditions – Give careful attention to the rights. 
· Look at past winners – Viewing the past winners will help you know if 
your style and techniques are a good fit for the judges. 
· Read the rules – Know how to properly submit for the contest. 
· Calibrate your monitor – Why throw away your chances with an im-
age that has poor color balance? Calibrate your monitor to ensure that 
the colors on your screen will match the print or the judge’s screen. 
· Take a quality image – Don’t submit sub-par work. On the rare 
chance that you win, that work will be attached to your name for many 
years. 
· Send a quality image – If your image needs to be reduced in size to 
fit the parameters of the contest, make sure you do so properly. Send the 
largest file allowed, and make sure that you check the file for compres-
sion issues before sending. 
· Clean up your image (if allowed) – We live in a digital world, and 
most of the images in the contest will be altered slightly. If digital manipu-
lation is allowed, do it! 
· Use the required gear – Some contests will specify what lenses or 
other gear should be used. Follow these specifications. 
Submit the appropriate information – Your contest may want to know 
what settings and gear you used or may require an essay. Submit all 
required information when submitting your image. 
These are all great tips, but remember not to fall victim to the following 
errors. When entering a photo contest. 
 

Don’t:  
· Enter something that isn’t yours – Claiming someone else’s work as 
your own is stealing, so don’t do it. 
· Manipulate images too much – Read the rules carefully, and try to 
keep your retouching to basic retouching, not actual manipulation, de-
pending on the terms of contest. 
· Take it personally – Photography is art. The judges are people with 
their own ideas about that art. Don’t take their opinions too personally. 
· Enter images that don’t fit – Most photo contests have highly specific 
goals and image requirements. Don’t enter images that aren’t a good fit. 
You are wasting your time and the judges’ time. 
· Submit a poor essay – If your contest requires an essay, take the 
time to proofread it. It needs to look professional, just like your image. 
Let personal fear keep you from entering – It’s easy as an artist to always 
second-guess your abilities. Don’t let your personal fear keep you from 
entering any contest. You just might have a winning image to submit! 

Photo Competitions - Do’s and Don’ts by Ashley Reeder  
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Email us at:  
info@sicc-photography-club.com 

 

Important SICC Websites 
Staten Island Camera Club Website   

hƩps://www.sicc-photography-club.com/ 
Image CriƟque Meetup Website  

hƩps://www.meetup.com/Image-CriƟque-Meetup/ 
Staten Island Camera Club Meetup/FSM   

hƩps://www.meetup.com/Staten-Island-camera-club/ 

For IMPORTANT ANNOUNCEMENTS 
 

Visit NJFCC 

http://www.njfcc.org/ 

HOLD THE DATE 
 

PHOTORAMA 2023 - Saturday,     
March 25, 2023 

 
You don't want to miss Photorama 

2023 - It's going to be a great event!  

 

The New Jersey FederaƟon of Camera 
Clubs (NJFCC) is an associaƟon of local 
camera clubs embracing a membership 

of more than eight hundred amateur 
photographers in New Jersey, New 

York and Pennsylvania. The NJFCC is 
dedicated to making photography more 

interesƟng and rewarding to the indi-
vidual, through service to his/her club 

and by pooling the resources of individ-
ual clubs for the benefit of all  

There are six categories to submit into for a monthly competition. You can enter 2 Color Digitals, 2 Color 
Prints, 2 Mono Digitals and 2 Mono Prints, as usual (8).  And now you can also enter in the Assigned 
Subject category two Digital and two in Print.(Which equals a total max of 12 images per competition) 
 
You are permitted to make up One missed Regular competition in each of the categories that you are
participating in; except for the Assigned Subject Competitions, which can not be made up. 
 
Digital entries must be submitted by 11:59 PM on or before the Tuesday evening prior to Thursday‘s
competition, using the upload procedures established by the Photo Contest Pro website. 
 
All print entries must be submitted and ready for Competition by 7:45 PM on the night of the Competition. 
Print Entry Sizes: Printed images will be no less than 8x 10”, but not more than 13x19”. Prints must be 
mounted on a board and can be single matted. Over all presentation size including the mat or backing board 
should not be less than 10X12”nor any larger than 17X22.” Commercially available mats for 8x10" sized 
prints are generally 11x14" with an opening for 8x10" prints and are available in local stores or on-line. 
 
The upper rear Left Hand corner of the print must contain our competition label filled in with the image’s 
Title, Member’s Name and the Color/Mono Category; checked in the appropriate box. Assigned 
Subjects are not numbered. The entry # on the Label (#1 or 2), must correspond to what is printed on the 
scorer’s sheet. 
 
All images, both Digital and Print, will follow the same scoring scheme. First Round entries that are 
scored a “6” or less will be dropped, any image scored a “7” makes it into the 2nd Round. 
During the 2nd Round the Judge will re-score the Photo and will either keep the "7" Score or raise  it to an 
"8" gaining an "Honorable Mention" or a "9" which is the designation for an Best in show "Award". 
 
Once a Photo receives an “Award” (9) it will be retired and may not be re-entered into any future 
regular Monthly Club Competition in the same or any other category. Any 9’s earned during the season 
can compete with other photos in the Photo of the Year competition. Photo of the year winning images 
also will be retired and restricted in the same manner as above. 
 
Any color Digital, or Print that received a 7 or 8 may not be re-entered into competition in the same season 
in the same category. However it may be re-entered in a succeeding season, only once, in a different 
category.  
 
Competitions are held in the Harbor Room, Snug Harbor Building G, on the third or fourth Thursday 
of each month at 8 PM.  (See our Schedule on our Website for exact dates and times.) 
 

Competition Guidelines 

Note: All Blue characters are Hyperlinks.   

    Ctrl Click with mouse or tap your stylist to follow the 
links on-line. 

Club Officers for 2022-2023 
President: Dennis Arculeo Secretary: Debbie Kilen 

1st Vice President: Eric Mayr Clix Editor: Dennis Arculeo 

2nd Vice President: Len Rachlin Competition Chair: Carol Mayr 

Treasurer: Carol Mayr Projectionist: Lauren Arculeo   

Events: Charlie DiBartolo Print Chair: Mike Miglino 


